LENESAS RELEASE NOTE

RZ/T1 Group RO1AN3635EJ0231

Rev.2.31
Encoder I/F A-format application package March 31, 2025
Summary

This document explains about RZ/T1 Encoder I/F A-format application package.
To use this application package, please obtain release package of “RZ/T1 Encoder I/F Configuration Library”.

Device that A-format functionality is checked
RZ/T1 CPU Board (RTK7910018C00000BE)
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RZ/T1 Group Encoder I/F A-format application package

Version History

Ver. Date Content Note

2.31 March 2025 | Update description of Release Note Summary.

2.30 October Update the RZ/T1 A-format sample driver code.
2019 (1) Fixed bug of disables input of the ELC event triggers
processing.
(2) Fixed bug initialization of the internal variables.
2.20 August Update the RZ/T1 A-format sample driver code.

2018 (1) Supported bypass reception for chl.

(2) Fixed bug of bypass reception processing.

(3) Changed the operation procedure of DS-5 and e2 studio.
(4) Added restriction

2.10 April 2018 Update the RZ/T1 A-format sample driver code.

(1) Added ID macro definition for chl.
(2) Changed register definition for chl.
Update the RZ/T1 Group A-format Interface User’s Manual.

2.00 April 2017 Update the RZ/T1 A-format sample driver code.

(1) Supported the Configuration Data Ver.1.8.
Updated Configuration Data to Ver.1.8.

(1) Added the bypass transmission and reception function using
FIFO.
(2) Added the received data setting completion Interrupt.
(3) Added the ELC Event Input Trigger.
Update the RZ/T1 Group A-format Interface User’s Manual.

Update the RZ/T1 Group A-format Sample Program Application

Note.
1.01 January Update the RZ/T1 A-format sample driver code.
2017 (1) Improved the stability of the module stop release operation.
1.0 September Fixed bug of interrupt routine of sample program.
2016 Update the RZ/T1 Group A-format Interface User’s Manual.
Update the RZ/T1 Group A-format Sample Program Application
Note.
0.8 June Fixed bug of macro value of sample program.
2016 Fixed bug of interrupt routine of sample program.
Fixed bug of terminal screen display of sample program.
Changing the input method of the console commands of the
sample program.
Update the RZ/T1 Group A-format Interface User’s Manual.
Update the RZ/T1 Group A-format Sample Program Application
Note (Japanese).
Added the RZ/T1 Group A-format Sample Program Application
Note (English).
0.7 October Newly created
2015
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RZ/T1 Group

Encoder I/F A-format application package

1. Contents of package

Contents of this package are described in this chapter.

Configuration data and sample programs in this package support only 1 channel of Encoder I/F. In order to use 2
channels of Encoder I/F, obtain the RZ/T1 group Encoder I/F 2ch Tool (RO1AN4306) and change the Configuration

Data and sample program.

1.1 Software
- Source code
No. Title Version
1 A set of RZ/T1 A-format sample driver code 25
- Configuration data
No. Title Version
1 RZ/T1 Encoder I/F Configuration Data(A-format) 1.8
1.2 Document
No. Document name Ver. File name
1 RZ/T1 Encoder I/F A-format application 2.31 (English)

package release note r01an3635ej0231-rzt1.pdf (this document)
(Japanese)
r01an3635jj0231-rzt1.pdf

2 RZ/T1 Group A-format Interface 2.10 (English)

User’s Manual r01uh0604€j0210-rzt1-a-format.pdf
(Japanese)
r01uh0604jj0210-rzt1-a-format.pdf

3 RZ/T1 Group A-format Sample Program 2.00 (English)

Application Note r01an2948ej0200_rzt1_a-format.pdf
(Japanese)
r01an2948;jj0200_rzt1_a-format.pdf
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RZ/T1 Group Encoder I/F A-format application package

2. File Structures

File structures and contents of this package are described below.

Top
—r01an3635ej0231-rzt1.pdf
—r01an3635jj0231-rzt1.pdf
—workspace
—Software
|  F—armcc
| | L—RZ T1 _a_as.zip : A setof RZ/T1 A-format sample driver code (DS-5)
|  F—iccarm
| | L—RZ_T1 _a_as.zip : Asetof RZ/T1 A-format sample driver code (IAR)
|  —kpitgcc
| L—RZ T1_a_as.zip : A set of RZ/T1 A-format sample driver code (e2 studio)
—Documentation
F—r01uh0604ej0210-rzt1-a-format.pdf
F—r01uh0604jj0210-rzt1-a-format.pdf
F—r01an2948ej0200_rzt1_a-format.pdf
—r01an2948jj0200_rzt1_a-format.pdf

The file structures of “RZ_T1_a_as.zip” are shown in Figure 2.1 File Structure.
= Top folder

o lib

5 ecl

b r_a_as_rzt1.dat Multi-Protocol Encoder IF (a_as mode) Configuration data

B inc

jodefine.h RZ/T1 register definition file

jodefine_a_as.h A-format register definition file

M r_a_as_rzt1_dat.h r_a_as_rzt1.dat header file

M r_a_as_rzt1_if.h A_AS common driver header file
D src

& common
< Common sources including initial settings
o drv
& scifa_uart
< SCIFA Sample program

D a_as
® r_a_as_rzt1_config.h A_AS common driver file
® r_a_as_rzt1_private.h A_AS common driver file
¢ r_a_as_rztl.c A_AS common driver file
B a_format

n  r_a_format_rzt1_config.n A-format driver file
r_a_format_rzt1_private.h A-format driver file

< r_a_format_rzt1.c A-format driver file
=  sample
< main.c A-format Sample program
a_as_dat.s Linker setting file of the Configuration data *1
< siochar.c SCIFA Sample program
< siorw.c SCIFA Sample program
RN_CommClass_RZ_T1.inf USB serial port driver for PC

Note 1 : file for DS-5 and e2 studio
DS-5:a_as_dat.s
e2 studio : a_as_dat_asm

Figure 2.1 File Structure
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RZ/T1 Group Encoder I/F A-format application package

3. Information about A-format sample program

This chapter describes information to use a set of A-format sample driver code.

3.1 Software information
3.1.1 Independent from Operating System

This software is independent from operating system.

3.1.2 Memory footprint

Memory Size
Section name IAR DS-5 e2 studio
[bytes] [bytes] [bytes]

A-format driver Code 6400 8440 16236
Data (with initial value) 16 26 16

Data (without initial value) 1160 1152 1164

Constant Data 132 132 140

Stack size of | R_A_AS Open 60 68 144

function R_A_AS Close 16 28 84

R_A_AS_Control 64 88 192

R_A AS_GetVersion 0 16 72

a_as0_int_isr 168+n *1 116+n *1 156+n *1

a_as0 fss_isr 160+n *1 100+n *1 132+n *1

A-format Code 0 0 0
Configuration Data (with initial value) 0 0 0
data Data (without initial value) 0 0 0
Constant Data 21932 21932 21932

Sample program | Code 6008 8676 14244
Data (with initial value) 136 152 136

Data (without initial value) 1829 1816 1836

Constant Data 2168 328 2138

Note 1. “n” is the Maximum stack size of user defined callback functions that are registered to R_ A AS_Control
function.
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RZ/T1 Group Encoder I/F A-format application package

3.2 Hardware information

3.21 Device
RZ/T1

3.2.2 Target Board

» Board name

RZ/T1 CPU Board (RTK7910018C00000BE)

(2) Settings of CPU Board
SW4-1: ON
SW4-2: ON in case of serial flash memory is used, OFF in case of NOR flash memory is used
SW4-3: ON
SW4-4: ON
SW4-5: ON
SW4-6: OFF
JP2: 2-3 Connect
JP7: 1-2 Connect
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RZ/T1 Group Encoder I/F A-format application package

3.3 Procedure on Development Environments

3.3.1 Preparation for the execution of the sample program
This sample program communicates with the PC. And for setting the PC, please refer to 6.1.2 Preparations of

"RZ/T1 Group FIFO Integrated Serial Communication Interface (SCIFA) Application Note".

3.3.2 EWARM from IAR systems

»  Build environment
IAR Embedded Workbench for ARM v8.40.1
»  Execution environment
I-jet
»  How to build sample program
1. Extract files from RZ T1_a as.zip and copy the files to arbitrary holder
2. Copy the following files of “RZ/T1 Encoder I/F Configuration Library” (for JAR EWARM) to each folder
lib\ecl\r_ecl rztl.a
inc\r_ecl rztl ifh
3.  Launch EWARM
4.  Select [File]menu -> [Open] -> [Workspace]
5. OpenRZ T1 a as boot\RZ T1 a as **** boot.eww

NOR version RZ T1 a as nor_boot.eww

Serial Flash version RZ T1 a as _serial boot.eww

6. Select [Projectmenu -> [Rebuild all]
Following file is generated.

RZ T1 a as boot\Debug\Exe\RZ T1 a as **** boot.out

NOR version RZ T1 a as nor_boot.out

Serial Flash version RZ T1 a as_serial boot.out

»  How to execute sample program

After executing “How to build sample program”, connect the target board and the debugger properly, and
execute the following operations.

1. Select [Project] menu-> [Download and Debug]

2. Select [Debug] menu-> [Go]
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RZ/T1 Group Encoder I/F A-format application package

»  Execution result of sample program

After executing a sample program, input the command to " Terminal I/O" window.
Please refer to RZ/T1 Group A-format Sample Program Application Note about the command.

12 COM9:115200baud - Tera Term VT L= | B |t
File Edit Setup Control Window Help

A-Format sample program start e
a_as 7
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RZ/T1 Group Encoder I/F A-format application package

3.3.3 DS-5 from ARM

>  Build environment
ARM Development Studio 5 (DS-5) Version 5.29.2
ARM Compiler 5.06 update 6

> Execution environment
ULINK2 (v2.01)

»  How to build sample program

1. Startup the DS-5 environment. Go to [File] > [Import]. On the [Import] window, select [Existing
Projects into Workspace] in the [General] folder and click the [Next] button.

2. Select the [Select archive file:] radio button and click on the [Browse...] button. Select the
compressed program file “RZ _T1 a as.zip” on the list in the window and click on the [Finish] button.

3. Copy the following files of “RZ/T1 Encoder I/F Configuration Library” (for ARM DS-5) to each
folder imported and expanded.

lib\ecl\r_ecl rztl.a
inc\r_ecl rztl _if.h
4.  Select [Project] menu -> [Build All]
Following file is generated.
Debug\RZ T nor sample.axf

(In case of serial flash, use the “RZ_T sflash sample.axf” instead of the “RZ_T nor_sample.axf”)
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RZ/T1 Group Encoder I/F A-format application package

»  How to execute sample program

After executing “How to build sample program”, connect the target board and the debugger properly, and
execute the following operations.

1. Open the debug configuration from the [Run] -> [Debug Configurations...], select the configuration
window for “RZ T nor DL and Debug”. (In case of serial flash, use the “RZ T sflash DL and Debug”
instead of the “RZ T nor DL and Debug”)

Select “Debug Cortex-R4” of “RZ/T1 R7S910x18 (Generic)” in [Select target].

Select the ULINK?2 of [Target Connection] in [Connection] tab, click on [Browse] and select the target
connection from the list in the window. Click on [Debug] in the debug configurations window and start
debugging.

< Debug Configurations

Create, manage, and run configurations

o
=| Rl EH s+~ Name: RZ_T_nor_DL_and_Debug

| -4e- Connection Files| #% Debugger ‘i OS Awareness| 9= Arguments| B Environment
[E] C/C++ Application .

Select & it
[€] C/C++ Attach to Application . e
[£] C/C++ Postmortem Debugger Select the manufacturer, board, preject type and debug operation to use. Currently selected:

Renesas / RZ/T1 R75910x18 (Generic) / Bare Metal Debug / Debug Cortex-R4
[€] C/C++ Remote Application ( ) 2 4

45 DS-5 Debugger
£5 RZ_T_nor_ConnectOnl
I A% RZ_T_nor_DL_and_Debug | (1)
5 RZ_T_nor_SymLoad_and_Debug
" IronPython Run

N

Filter platforms

» RZ/T1 R75910x16 (Generic) -
» RZ/T1 R75210x17 (Generic)
4 RZ/T1 R75910x18 (Generic)

&’ IronPython unittest 4 Bare Metal Debug
4 Java Applet Debug Cortex-M3

Debug Cortex-Ra | (2)
[T Java Application L)

Ju Junit » RZ{T1 RTK7910018500000BE |

A7 Jython run

& on ot el reo—

B Launch Group DTSL Options Configure ULINK2 trace or other target options. Using "default" configuration options
B3 pyDev Djange

L5 PyDev Google App Run DS-5 Debugger will connect to a ULINK2 to debug a bare metal application.

' python Run -
& Pyl _
&’ Python unittest Connections )

B Remote Java Application Bare Metal Debug | Connection S

m

] 1 3

Anply
Filter matched 21 of 21 items LaY
=)

(":7:. I[ Debug ] | [ Close
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RZ/T1 Group Encoder I/F A-format application package

2. On completion of writing to the flash memory by the script, the message “Flash Programming Complete”

appears in the application console window. Debugging can then start.

S DS-5 Debug - Eclipse Platform
File Edit Navigate Search Project Run Window Help

+set var $CP15::3System: :3CP15_AUXILIARY_CONTROL.ATCMPCEN = 1
Target has been reset
Execution stopped in SVC mede due to a breakpoint or watchpoin

[E=/ e =)

- SRR » HC SR e e Quick Access || 5 | BRI[ER)
B Command: 33 & G B8 >8 ®=Va. 3 i = A8
%, Linked: RZ_T_nor_DL_and_Debug - $ -
ARNING(CMD31S): T2 running o <5, Linked: RZ_T_nor_DL_and_Debug =
+reset
4 @& RZ_T_nor_DL_and_Debug connected +info memory Name Value Type|Count Size Lo
4 3 Cortex-Ra #1 stopped on breakpoint Num Enb Low Addr High Addr Attributes (= Locals 0 variables
= OxFFFF0000 1: y APEB:@xBBOEEERO APE:@xFFFFEFFF rw, nobp, nohbp, nocache (= File Static Variables 0 of 31 variables
- 2: y  AHB:@xBBBBBEBB AHB:@xFFFFFFFF rw, nobp, nohbp, nocache (= Globals 0 of 3 variables
3: y  ©x00000000 BXFFFFFFFF rw, nocache, verify

@xFFFF@e08  LDR pc,[pe,#24] ; [@xFFFF@@28] = BxFFFFB040 |5

+set var $CP15::3System: :$CP15_AUXILIARY_CONTROL.B@TCMPCEN = 1

+file ".\RZ_T_nor_sample\DebughRZ T nor_sample.axf” s

4 I r 1 111

W& RZT_nor DL and Debug connected
g

loop=5, Could not open file. Exiting.
Flash Programming Complete i it

Q RZ_T_nor_DL_and_Debug connected (Renesas - RZ/T1 RTK7910022C00000BR)

No 05 Support Command:
B App Console 32 G G aE = = a
<§;Lmked: RZ_T_nor_DL_and_Debug ~ & =
loop=2, file=LOADER_RESET_HANDLER, flash address=@x48080200. - G, Linked: RZ_T_nor_DL_and_Debug =
Calculating Data Size... - =
Data Size is 3303 @ g = <NextInstruction> 100
Programing Flash... Address | Opcode | Disassembly
Verifying Flash... . % @xFFFFeoee LDR pc,[pc,#24] ; »
loop=2, Flash Programming Success!! OuEEFFBR0L LDR pe, [pe,#24] :
loop=3, file=LOADER_IN_ROOT, flash address=@x48006200. oxFEFFRG0S LoR oo [pco#2a] 31
Calculéflﬂg Data Size... AxFFFFBBAaC LDR pe, [pc,#2a] ;
Data size 15119E BxFFFFBA10 LDR pc, [pe,#24] ;
PFDE;WI"ME ; E; BxFFFFBa14 LDR pc,[pc,#24] ;
Verifying Flash... . OxFFFFeaLs LDR pc, [pe,#24] ;
loop=3, Flash Programming Success!! BxFFFFRRLC LDR pc,[pc,#24] ;
loop=4, file=INIT, flash address=ex48028080. BxFEFFRE20 bt OxFFffosan ; °
Calculéflﬂg Data Size... 3 AxFFFFRB24 DCT axffffoe7a ; >
Data Size 15141:33 OxFFFFE028 DCT exffffeo7a ; ?
Prﬂg;a[ﬂlﬂg ; E; BxFFFF@02C DCI exffffee7s ; 2
Verifying Flash... . @xFFFFB830 DCI exffifee7c ; ?
loop=4, Flash Programming Success!! BxFEEFBE34 DCI exffffease 2

»  Execution result of sample program

After executing a sample program, input the command to " Terminal I/O" window.
Please refer to RZ/T1 Group A-format Sample Program Application Note about the command.

. COM9:115200baud - Tera Term VT EIE‘—J

File Edit Setup Control Window Help
A-Format sample program start e
aas >
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RZ/T1 Group Encoder I/F A-format application package

3.34 e2 studio from RENESAS

>  Build environment

RENESAS e2 studio 7.5.0

KPIT GNUARM-NONE-EABI Toolchain v16.01
>  Execution environment

J-Link BASE
»  How to build sample program

1. Start up the e2 studio environment. In the workspace, go to [File] > [Import]. On the [Import]
window, select [Existing Projects into Workspace] in the [General] folder and click the [Next] button.

2. Select the [Select archive file:] radio button and click on the [Browse..] button. Select the compressed
program file “RZ T1 a as.zip” on the list in the window and click on the [Finish] button.

3. Copy the following files of “RZ/T1 Encoder I/F Configuration Library” (for KPIT GCC) to each
folder imported and expanded.

lib\ecl\r_ecl rztl.a
inc\r_ecl rztl if.h
4.  Select [Project] menu -> [Build All]
Following file is generated.
HardwareDebug\ RZ T nor_sample.x

(In case of serial flash, use the “RZ T sflash sample.x” instead of the “RZ_T nor sample.x”)
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RZ/T1 Group Encoder I/F A-format application package

»  How to execute sample program

After executing “How to build sample program”, connect the target board and the debugger properly, and
execute the following operations.

1. Select [Run] from the [Project] menu and then select [Debug Configurations].

2. Select the [RZ T nor sample HardwareDebug] in the following screen. Click the [Debug] and start the
download to flash memory.

(In case of serial flash, use the [RZ T sflash sample HardwareDebug] instead of the
[RZ T nor sample HardwareDebug])

Debug Configurations

Create, manage, and run configurations

= -+
= x| H &~ Mame: RZ_T_nor_sample HardwareDebug

type filter text [ Main ._%s Debugger| = Startup| & Source| ] Commeon

[€] C/C++ Application
[£] C/C++ Remote Application
@ Debug-only RZ_T_nor_sample ’ Browse... ]
[£] GDB Hardware Debugging
» [£7] GDB Simulator Debugging (RL78, SH, RH850)
= Launch Group
4 [t7 Renesas GDB Hardware Debuqgging Variables. .. l l Search Project... l ’ Browse... ]
I@ RZ_T_nor_sample HardwareDebug I
[E1 RZ_T_sflash_sample HardwareDebug

Project:

C/C++ Application:

HardwareDebug¥RZ_T_nor_sample.x

Build (if required) before launching

[ Renesas Simulator Debugging (RX) Build configuration: ’Use Active vl
(71 Enable auto build () Disable auto build
@ Use workspace settings Configure Workspace Settings...
4 m »
Apply Revert
Filter matched 12 of 14 items S -

)
(?,' I Debug I l Close

3. Click the [Resume] from the [Run] to start execution of the sample program.

»  Execution result of sample program

After executing a sample program, input the command to " Terminal I/O" window.
Please refer to RZ/T1 Group A-format Sample Program Application Note about the command.

1% COM9:115200baud - Tera Term VT L= | ) e
File Edit Setup Control Window Help

A-Format sample program start e
a_as >
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RZ/T1 Group Encoder I/F A-format application package

4. Restriction

4.1 RZ/T1 A-format sample driver

»  When bypass reception is enabled, member variable "rxbpende" of structure "r_a_as req t" sets enable or
disable of FSS_UPD interrupt request by FSS.RXEND bit = 1. If set to disable, A-format sample driver
will not operate properly. Therefore, member variable "rxbpende" of structure "r_a as req t" must be
fixed to "true".

5. Note

5.1 Processing time

Available time for user processing of Encoder I/F A-format sample program in a control loop is as follows.
Please confirm that there are no problems in your environment.
The example of the case that the control cycle is 62.5us and the connection type is one to one is indicated below.

In the case of normal reception, the time used by the sample program is about 9 us (15%) of 62.5us, and available
time for user processing is about 53.5 us (85%).

In the case of bypass reception, the time used by the sample program is about 6 us (10%) of 62.5us, and available
time for user processing is about 56.5 us (90%).

Processing Time Occupancy rate
A-format sample | normal reception Time setting registers for | about 4 us about 9 us 15%
processing *2 transmission
Interrupt time about 5 us
Available time for user about 53.5 us *1 85%
processing
bypass reception Time setting registers for | about 4 us about 6 us 10%
transmission
Interrupt time about 2 us
Available time for user about 56.5 us *1 90%
processing

Note 1. Communication time with the encoder (when the bitrate is 8Mbps and the command to be sent is CDF0
which is individual transmission command) is 17.75us of available time for user processing. For more information,
refer to the “RZ/T1 Group A-format Interface User's Manual”.

Note2. Initial setting time is not included.
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RZ/T1 Group Encoder I/F A-format application package

5.2 About mistake of Application Note
The following mistake is existing in "RZ/T1 Group A-format Sample Program Application Note Rev.2.00".

» Table 5.4 Results of Transmission and Reception Stored in Each Array Element in Bypass Reception
Correct:

Array Number  Content

pbp_result[0] Result of transmission and reception for the encoder section ENC1 when the setting of received data is
complete(RXSET).

pbp_result[1] Result of transmission and reception for the encoder section ENC2 when the setting of received data is
complete(RXSET).

pbp_result[2] Result of transmission and reception for the encoder section ENC3 when the setting of received data is
complete(RXSET).

pbp_result[3] Result of transmission and reception for the encoder section ENC4 when the setting of received data is
complete(RXSET).

pbp_result[4] Result of transmission and reception for the encoder section ENC5 when the setting of received data is
complete(RXSET).

pbp_result[5] Result of transmission and reception for the encoder section ENC6 when the setting of received data is
complete(RXSET).

pbp_result[6] Result of transmission and reception for the encoder section ENC7 when the setting of received data is
complete(RXSET).

pbp_result[7] Result of transmission and reception for the encoder section ENC8 when the setting of received data is
complete(RXSET).

pbp_result[8] Result of transmission and reception when the transmission and reception of data has been
completed(RXEND)™.

Notel. The result is invalid when the interrupt source RXEND is disabled.

Incorrect:

Array Number  Content

pbp_result[0] Result of transmission and reception for the encoder section ENC1 when the setting of received data is
complete(RXSET).

pbp_result[1] Result of transmission and reception for the encoder section ENC2 when the setting of received data is
complete(RXSET).

pbp_result[2] Result of transmission and reception for the encoder section ENC3 when the setting of received data is
complete(RXSET).

pbp_result[3] Result of transmission and reception for the encoder section ENC4 when the setting of received data is
complete(RXSET).

pbp_result[4] Result of transmission and reception for the encoder section ENC5 when the setting of received data is
complete(RXSET).

pbp_result[5] Result of transmission and reception for the encoder section ENC6 when the setting of received data is
complete(RXSET).

pbp_result[6] Result of transmission and reception for the encoder section ENC7 when the setting of received data is
complete(RXSET).

pbp_result[7] Result of transmission and reception when the transmission and reception of data has been
completed(RXEND)™.

Notel. The result is invalid when the interrupt source RXEND is disabled.

»  Table 5.20 Static Variables Used in the Sample Program

Correct: a as _bp resultfA AS BP RESULT NUM]
Incorrect: a_as_bp resultfA AS ENC NUM]
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